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 Het ontwerp van de domein laag
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 Sprint backlog
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 Aanmaken van het Banking project
◦ Create a new Project> C# (language) en Console (project type) 

> Console App(.Net Core) 

◦ Geef naam “Banking” in en kies een locatie. Vink place 
solution and project in same directory uit
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 Aanmaken van het Banking project
◦ We splitsen de use case op in taken, die we, eens afgerond, 

committen. We werken in een lokale git repository. In de 
Solution Explorer > rechtsklik solution Banking > Create Git 
Repository. (of onderaan )

 Dit creërt reeds 2 commits.  Klik onderaan op master > View 
History
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 Aanmaken van de domein laag
◦ Maak een folder “Models” aan binnen het Banking project. 

Daarbinnen de folder “Domain”. Dit bevat de domeinklassen. 
Deze zullen allen behoren tot de namespace
Banking.Models.Domain

 (rechtsklik Banking project > Add > New folder)
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 Aanmaken van een klasse

 Members van een klasse
◦ Fields

◦ Methods

◦ Constructor

◦ Destructor

◦ Properties

◦ Region

 Aanmaken members van een klasse

 Gebruiken van een klasse

 Class View/Object Browser
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 Aanmaken van een domeinklasse BankAccount
(eenvoudige versie)
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Wordt later 
vervangen door een 
Property



 Aanmaken van een domeinklasse BankAccount
◦ Rechtsklik op de folder Domain > Add > New Item > Class. 

Geef de klasse de naam “BankAccount” 
◦ In de folder Models/Domain wordt bestand BankAccount.cs

aangemaakt

 Naming conventions: 
https://github.com/aspnet/Home/wiki/Engineering-guidelines
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https://github.com/aspnet/Home/wiki/Engineering-guidelines


 Aanmaken van een domeinklasse
◦ Dubbelklik BankAccount.cs in Solution Explorer, dit opent de 

code editor

◦ De code:
 using statements: de gebruikte assemblies

 er staan een aantal niet gebruikte using statements. Ga er over met de 
muis, het lampje verschijnt en klik “Remove unnecessary usings”. Of 
run code cleanup.

 namespace Banking.Models.Domain {} 

 Een namespace is een logische groepering van gerelateerde klassen 
(packages in Java). 

 Alle klassen in de folder Models/Domain behoren tot deze namespace.
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 Aanmaken van een domeinklasse
 class BankAccount {}: de klasse definitie

 Access modifiers voor een “niet geneste” klasse

 public

 ongelimiteerd toegankelijk

 internal

 toegankelijk binnen de assembly

 indien geen access modifier gebruikt wordt is dit de default
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een .NET assembly komt ongeveer overeen met een Java .jar file, 

.Net’s internal visibility komt ongeveer overeen met package (default) 
visibility in combinatie met een sealed .jar

Als je unit testen wenst aan te maken voor een klasse, dient de klasse public 
te zijn. Unit testen behoren tot een andere namespace (zie verder)



 Members van een klasse
◦ Fields (Attributen)

◦ Constructor – destructor

◦ Properties

◦ Methods

◦ Events
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 Access modifiers voor members
◦ public

 ongelimiteerd toegankelijk

◦ private

 enkel toegankelijk binnen de klasse

 dit is de default

◦ internal

 enkel toegankelijk binnen de assembly

◦ protected

 enkel toegankelijk binnen de klasse en binnen klassen die erven van 
de klasse

◦ Protected internal

 Letterlijk een combinatie van internal en protected
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Java protected: toegankelijkheid tot klassen die erven en tot klassen binnen 
dezelfde package (dit is verschillend van C# protected!)



1. Fields (Attributen)
◦ Inkapseling van data

◦ Kunnen variabelen of constanten zijn
 Attributen geven we steeds private access

◦ Kunnen static zijn

 zijn gekoppeld aan de klasse en niet aan een instantie (object) van de 
klasse, ze bestaan slechts 1 maal per klasse.

◦ Namingconventie: _camelCase
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[modifier] datatype variableName



1. Fields (Attributen)
◦ Constanten

 gebruik keyword const

 een constant field moet geïnitialiseerd worden bij declaratie

 na initialisatie kan de waarde van een const nooit meer
veranderen

 een const is impliciet static:

 je gebruikt geen static bij declaratie

 je gebruikt de naam van de klasse om de constante op te vragen

 Namingconventie: Start met hoofdletter
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dit heeft geen 
equivalent in Java…



1. Fields (Attributen)
◦ readonly

 gebruik keyword readonly

 aan een readonly field kan slechts 1 keer een waarde worden
toegekend

 bij declaratie of

 in constructor

 Hoeft niet in de declaratie <> CONST
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equivalent in Java: 
final



2. Methods
◦ Operaties die een object kan uitvoeren. 

◦ Kunnen al dan niet (void) een waarde retourneren.

◦ Kunnen static gedeclareerd worden.

◦ Bevatten parameter lijst: parameters gescheiden door een komma, 
parameters hebben type en naam, gebruik () indien geen parameters.  

◦ Method overloading: je kan meerdere methodes hebben met dezelfde 
naam. Ze verschillen in aantal argumenten en/of type van argumenten.
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[modifier] return_type MethodeName ([parameters]) { … }

Voor Java programmeurs 
even wennen: 

methodenamen starten 
met een HOOFDLETTER!



2. Methodes (vervolg)
◦ Parameters kunnen optioneel zijn (geen method overloading nodig)

 bij declaratie ken je aan een optionele parameter een defaultwaarde
toe

 voor een optionele parameter hoef je geen waarde mee te geven bij 
aanroep

 optionele parameters staan als laatste in de parameterlijst

 Intellisense gebruikt [] om optionele pars aan te duiden

 voorbeeld:

 declaratie van een methode met een optionele parameter

 aanroepen van een methode met een optionele parameter
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public void ExampleMethod(int required, int optionalInt = 10)

ExampleMethod(5);    // optionalInt uses the defaultvalue 10

ExampleMethod(5, 8); // optionalInt uses the supplied value 8



2. Methodes (vervolg)
◦ Optionele parameters en named arguments

 igv een optionele parameterlijst, waar bij aanroep niet alle 
parameters een waarde hebben

 voorbeeld:

 declaratie van een methode met een optionele parameterlijst

 aanroepen van een methode met sommige optionele parameters
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public void ExampleMethod(int required, string optionalstr = 
"default string", int optionalint = 10)

ExampleMethod(5, ,3); // geeft een compilatiefout

ExampleMethod(5, optionalint : 8); // optionalInt gebruikt de 
opgegeven waarde 8, optionalstr de default value “default 
string”



2. Methodes (vervolg)
◦ Parameters passing kan op 3 manieren gebeuren

 Value parameters: input parameter

 Ref parameters: input/output parameters
 je moet expliciet ref vermelden bij formele en actuele parameter

 de variabele die je doorgeeft moet geïnitialiseerd zijn

 elke verandering aan de ref-parameter in de aangeroepen methode zal ook 
doorgevoerd worden op de ref-parameter die werd doorgegeven

 Out parameters: output parameter
 je moet expliciet out vermelden bij formele en actuele parameter

 de variabele die je doorgeeft hoeft niet geïnitialiseerd zijn

 de aangeroepen methode moet een waarde geven aan de out-parameter

◦ voorbeeld:
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int i = 0;
Test1(i);     // i heeft nu de waarde 0
Test2(ref i); // i heeft nu de waarde 1
Test3(out i); // i heeft nu de waarde 10

public void Test1(int x) { x += 1; }
public void Test2(ref int x) { x += 1; }
public void Test3(out int x) { x = 10; }

Java kent enkel deze vorm



2. Methodes (vervolg)
◦ Parameters passing kan op 3 manieren gebeuren
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Hoezo, in Java heb je enkel value parameters???

In Java zeggen we steeds “Objects are passed by reference”, dit betekent echter dat de 
reference van het doorgegeven object als value parameter wordt doorgegeven…

public static void Demonstrate(ref BankAccount bankAccount) {
bankAccount = null;

}

public static void ShowDemo() {
BankAccount myAccount = new BankAccount();
Console.WriteLine(" myAccount is null: {0}", myAccount == null);
Demonstrate(ref myAccount);
Console.WriteLine(" myAccount is null: {0}", myAccount == null);

}

de reference naar het object myAccount wordt als ref parameter doorgegeven, 
alles wat Demonstrate doet met de formele parameter bankAccount wordt ook op de actuale parameter 

myAccount doorgevoerd… (laat je het ref keyword weg, dan wordt 2 maal myAccount is null: False afgeprint)



2. Methodes (vervolg)
◦ Je kan ook een return type opgeven

◦ return statement

 Kan om het even waar staan in de code  van de methode en kan
meerdere malen voorkomen

 Retourneert de waarde van de methode

 Uitvoering methode wordt onmiddellijk gestopt (eventueel na
uitvoering finally bij exception handling of Dispose bij using), en 
de controle wordt teruggegeven aan oproepend programma.
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3. Constructor
◦ Een constructor heeft steeds dezelfde naam als de klasse, en heeft 

nooit een return type.

◦ Een klasse hoeft geen constructor te hebben. In dat geval maakt de 
compiler zelf een default constructor (public naamklasse()) aan. 

◦ Een klasse kan 1 of meerdere constructors hebben. Ze verschillen in 
aantal argumenten en/of type van argumenten. In dat geval hoeft de 
klasse geen default constructor te hebben en maakt de compiler ook 
geen default constructor aan.
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Handige code snippet: ctor + tab
 genereert constructor methode

Klik Ctrl+K, Ctrl-X voor een overzicht van alle code 
snippets…

In Java zet je dit als eerste statement in 
de constructor body



3. Constructor
◦ Ook bij constructors kunnen default parameters opgegeven 

worden. Geen overloading nodig
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4. Destructor
◦ Kuist objecten op

◦ Wordt automatisch uitgevoerd voor de garbage collector een 
object vrij geeft.

◦ Heeft geen access modifier – geen parameters en heeft 
dezelfde naam als de klasse met een tilde voorafgegaan.

◦ Wordt zelden expliciet geschreven. Je weet ook niet wanneer 
het wordt uitgevoerd. Beter om IDisposable te gebruiken.
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5. Properties
◦ combinatie van aspecten van fields en methods

 voor de gebruiker van een klasse is een property net een field

 voor diegene die een property implementeert bestaat een 
property uit 1 of 2 stukjes code die de getter en/of setter 
voorstellen

 de code voor de getter wordt uitgevoerd wanneer de property wordt 
gelezen

 de code voor de setter wordt uitgevoerd als aan de property een 
waarde wordt toegekend
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5. Properties

Pag. 31

• de property noemt AccountNumber, 
de naam van een property start 
steeds met een hoofdletter!

• het type van de property is string

• dit stukje code bij get wordt 
uitgevoerd wanneer de property 
wordt gelezen, bv.

string accountNumber = 
myBankAccount.AccountNumber;

• dit stukje code bij set wordt 
uitgevoerd wanneer aan de property 
een waarde wordt toegekend, bv.

myBankAccount.AccountNumber =
"12-456376-25";

• dit is een C# keyword

• het type van value is het type van de property, in dit 
voorbeeld dus string

• het bevat de waarde die de gebruiker wil toekennen 
aan de property



public class BankAccount {

private String accountNumber;

public String getAccountNumber() {

return accountNumber; }

public void setAccountNumber(String value) {

accountNumber = value; }

}

5. Properties:

public class BankAccount {

private string _accountNumber;

public string AccountNumber

{

get { return _accountNumber; }

set { _accountNumber = value; }

}

}

BankAccount myBankAccount =

new BankAccount("13-455665-13");

string accountNumber =

myBankAccount.AccountNumber;

myBankAccount.AccountNumber = "12-456376-25";

BankAccount myBankAccount =

new BankAccount("13-455665-13");

String accountNumber =

myBankAccount.getAccountNumber();

myBankAccount.setAccountNumber("12-456376-25");

JAVA C#



5. Properties
◦ Hoeven niet steeds een get en een set te bevatten

 read-only property: heeft enkel een get. 

 write-only property: heeft enkel een set

◦ get/set nemen per default het access level aan van de 
property, maar dit kunnen we veranderen

◦ voorbeeld
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private set: buiten deze klasse is het niet toegestaan de 
balans rechtstreeks te wijzigen

public get: de get heeft geen 
expliciete access modifier en 
neemt het access level van de 
property over



5. Properties – automatic properties
◦ properties hoeven niet expliciet gebruik te maken van een 

field

◦ er is een verkorte schrijfwijze voor properties

 de compiler maakt dan achter de schermen gebruik van een field

◦ voorbeeld
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uitvoering van get wordt achter de 
schermen vertaald naar:

return compiler_generated_field_for_Balance

er worden geen code blokken 
gedeclareerd voor get/set,

de compiler houdt nu zelf een 
private decimal field _balance bij

dit field is niet rechtstreeks 
beschikbaar voor de programmeur

uitvoering van set wordt achter de 
schermen vertaald naar:

compiler_generated_field_for_Balance = value



5. Properties
◦ bij automatic properties kan je ook het access level aanpassen

◦ voorbeeld

◦ handige code snippet voor automatic property: prop + tab tab

◦ handige shortcut om voor een field een property te maken
 selecteer field > rechtsklik > Quick Actions and Refactorings … > Encapsulate

Field
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5. Properties
◦ Auto-Implemented Property Initializers

◦ Je kan ook de initiële waarde van een property opgeven. Zo 
hoef je dit niet in de constructor te doen

◦ Voorbeeld

◦ Een read-only property heeft enkel een getter. De waarde kan
je opgeven via een auto-property initializer of in de 
constructor
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6. Regions
◦ Dienen om code te groeperen

 Een region kan je open- en dichtklappen

◦ Aanmaken: selecteer een stukje code selecteren > Rechtsklik > 
Snippet >Surround with > Visual C# > #region of typ de code in.

◦ Good practice: voorzie in een klasse minstens 4 regions: Fields, 
Constructors, Methods, Properties
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 Aan de slag nu…
◦ Implementeer de klasse

◦ Om een klassendiagram toe te voegen : rechtsklik folder 
Domain > Add > new Item > Class Diagram. 

 Selecteer BankAccount.cs in de Solution Explorer en drop het in 
de editor. 

 Aanpassen door Rechtsklik > Add > property,…. => de code in de 
klasse wordt automatisch aangepast
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 Aan de slag nu…
◦ Implementeer de klasse
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 Gebruik van klassen (ga naar Program.cs)
◦ Declaratie en instantiatie van een variabele van het type 

BankAccount

 Declaratie en instantiatie kan in 1 statement
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 Object Initializers
◦ Waarden toekennen aan properties

van een object, tijdens de
instantiatie van het object 

◦ Instantiatie en initialisatie zonder object
initializer:

◦ analoog maar met object initializer:
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Na de constructor aanroep volgt een sequentie van member initializers: tussen { } en 
gescheiden door een komma. Voor de default constructor mag je de haakjes bij de aanroep
weglaten.



 Gebruik van klassen
◦ Uitvoeren van een methode

 void

 met return waarde

◦ Gebruik van properties: 

 de compiler bepaalt zelf wanneer get of set wordt uitgevoerd (kan afgeleid 
worden uit plaats in code)

 Uitvoeren get (opvragen inhoud)

 Uitvoeren set (instellen inhoud) (enkel indien setter public)

 Beide (uitvoeren get en dan set)
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myAccount.Deposit(100.0M);

string accountInfo = myAccount.ToString();

string balance = myAccount.Balance.ToString();

myAccount.Balance = 100;

myAccount.Balance += 100;



 Gebruik van klassen
◦ Ga naar Program.cs en voeg onderstaande code toe

◦ Run de applicatie
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 Aanmaken commit in de lokale repository
◦ BankAccount is aangemaakt

◦ We gaan dit committen in de lokale repository

◦ Open Team Explorer (View > Team Explorer)
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commit “Add class BankAccount”



 Aanmaken commit in de lokale repository
◦ Klik op Changes
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 Aanmaken commit in de lokale repository
◦ Alvorens je commit, inspecteer je de code (code review)

◦ Open BankAccount.cs

 Overloop de code

 Bekijk nog eens de warnings en messages en pas code cleanup
toe
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 Aanmaken commit in de lokale repository
◦ Alvorens je commit, inspecteer de code

◦ Open Program.cs

 Team Explorer toont de verschillen. Overloop deze

 Code cleanup
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 Aanmaken commit in de lokale repository
◦ Vul de commit boodschap in en klik Commit All
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 Aanmaken commit in de lokale repository
◦ 7 REGELS VOOR EEN GOEDE COMMIT MESSAGE

 1. Hou onderwerp en body gescheiden met 1 witregel

 2. Beperk de lengte van het onderwerp tot 50 karakters

 3. Het onderwerp begint met een hoofdletter

 4. Gebruik geen punt op het einde van het onderwerp

 5. Gebruik de gebiedende wijs in het onderwerp

 6. Beperk de breedte van de body tot 72 karakters

 7. Geef in je body een uitleg voor wat en waarom, niet over hoe

 Meer op: http://chris.beams.io/posts/git-commit/
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http://chris.beams.io/posts/git-commit/


 Eventueel pushen commit naar Remote Repository
◦ Klik op Home  e

◦ Kies Sync. Hier kan je publiceren naar een Remote Repository
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 Klasse Transaction : immutable klasse
◦ Bijhouden van verrichtingen
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 Maak de Enumeratie aan
◦ Rechtsklik Domain folder > Add > new Item > Class. Naam 

TransactionType.cs

◦ Verwijder ”unused” using statements
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 Maak de klasse Transaction aan 
◦ Maak zelf de klasse Transaction aan 

◦ Maak van Amount, DateOfTrans,TransactionType

◦ Maak van IsDeposit en IsWithdraw read only properties

◦ Implementeer de klasse Transaction
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 Implementatie
◦ Alle props zijn readonly => immutable
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 Implementatie (vervolg)
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Als je get selecteert, dan verschijnt het lampje. We kunnen 
hiervoor gebruik maken van expression bodies. Zie volgend 
hoofdstuk.



 Om de transactions bij te houden maken we gebruik van 
Collections

 Namespace: System.Collections.Generic

 Een generische collection is strongly typed (type safe): dit
betekent dat het maar 1 type van object kan bevatten

 Collections worden ook
generics genoemd in .Net

 Meer op: 
http://msdn.microsoft.com/en-us/library/0sbxh9x2.aspx
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http://msdn.microsoft.com/en-us/library/0sbxh9x2.aspx


 Collection Interfaces
◦ interfaces laten je toe om loosely coupled, testable code te

schrijven

 methodes geven liever collecties terug via een interface dan via 
een concreet type

◦ we gaan even kijken hoe collecties in C# georganiseerd zijn

 als je de interfaces begrijpt ga je de collections zelf beter
begrijpen en gebruiken
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 Collection Interfaces
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dit zijn de core generic interfaces die we behandelen in deze 
cursus



 IEnumerable<T>
◦ meest belangrijke interface, zegt dat we over de elementen 

kunnen itereren

◦ biedt een enumerator aan om door een collectie te lopen.

 dit betekent dat je de collectie kunt doorlopen met een foreach
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slechts 1 methode in 
deze interface!



 IEnumerable<T>

◦ Merk op: T is een generic type parameter die je bij definitie 
van een collectie moet opgeven.
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Merk op: List<string> is de 
concrete implementatie. 
Merk op: We maken hier 
gebruik van een collection
initializer.



 ICollection<T>
◦ implementeert IEnumerable<T>

◦ extra properties en methodes laten toe om de grootte van de 
collectie op te vragen en de collectie te manipuleren
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 ICollection<T>
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 ICollection<T>
◦ voorbeeld: Count, Add, Remove Contains…
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 IList<T>
◦ implementeert ICollection<T>

◦ index gebaseerde toegang tot de elementen van de collectie

 0-based indexing

 gebruik rechte haakjes: [index]

◦ enkele methodes:

 een element aan de collectie toe te voegen op een specifieke
plaats: Insert

 een element uit de collectie weghalen van een specifieke plaats: 
RemoveAt

 de plaats van een element in de collectie te bepalen: IndexOf
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 IList<T>
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 IList<T>
◦ voorbeeld: gebruik index, Insert, RemoveAt, IndexOf, …
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 Klasse BankAccount
◦ Voorzie in de klasse BankAccount een generische lijst van 

transacties. Initialisatie kan bij declaratie of in de constructor
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 Klasse BankAccount
◦ Voeg extra properties en methodes toe
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NumberOftransactions
is een read-only
property

Nullable types: zie 
hoofdstuk 2



◦ De methodes Withdraw en Deposit
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◦ Pas Program.cs aan (later zien we unit testen)
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 Commit
◦ Voer code review uit

◦ Commit boodschap: Add class Transaction

◦ Klik eens op link Actions > View History. Zo kan je de detail van 
elke commit bekijken.
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commit “Add class Transaction 
(Associaties)”





 Overerving is een mechanisme waarbij software 
opnieuw wordt gebruikt: nieuwe klassen worden
gecreëerd vertrekkende van bestaande klassen
◦ De superklasse bevat de gemeenschappelijke attributen, 

operaties en associaties

◦ De subklasse erft alles van de superklasse: attributen, 
operaties, associaties

◦ In een subklasse wordt het gedrag van de superklasse 
uitgebreid en/of gespecialiseerd

 Het gedrag van de subklasse kan verder gespecialiseerd worden
door methoden van de superklasse te overriden (herdefiniëren) in 
de subklasse.

◦ De subklasse heeft een ‘is een’ relatie met de superklasse
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◦ Maak klasse SavingsAccount aan.

Pag. 75



 Definitie superklasse

◦ Opmerking: indien van een klasse niet mag worden afgeleid 
kan je de klasse verzegelen
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public class BankAccount

public sealed class BankAccount

Het equivalent in Java is een final class



 Definitie subklasse

◦ Bij een subklasse hoort steeds één superklasse. Net zoals Java 
laat .Net laat geen multiple inheritance toe. Een klasse kan 
wel meerdere interfaces implementeren

◦ Access

 De private members (attributen/methoden) van de superklasse
zijn niet toegankelijk vanuit de subklasse.

 De protected members uit de superklasse, zijn enkel toegankelijk
in de subklassen, niet voor de buitenwereld.
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public class SavingsAccount: BankAccount

de: operator wordt in Java extends

In Java laat je met protected access ook toegang vanuit andere 
klassen binnen dezelfde package toe…



 Constructors
◦ Constructoren van de superklasse worden niet overgeërfd

door de subklassen.

◦ Als de subklasse geen constructor bevat, maakt de compiler 
zelf een default constructor aan, die automatisch de 
constructor van de superklasse oproept. 

 Als de superklasse dan geen default constructor bevat krijg je een 
compiler fout

◦ Keyword “base”: aanroepen methode/constructor uit 
superklasse

◦ Keyword “this”: refereren naar de huidige instantie

Pag. 78

base komt overeen met Java super



◦ Voorbeeld
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SavingsAccount erft van de superklasse 
BankAccount

base: aanroepen constructor uit 
superklasse voor initialisatie 
members van superklasse

Voorbeeld oproepen constructor van eigen klasse:

public SavingsAccount(string bankAccountNumber, decimal interestRate, bool
goldMember): this(bankAccountNumber, interestRate)

Enkel SavingsAccount en
klassen die erven van 

SavingAccount hebben
toegang tot WithdrawCost



public class SavingsAccount: BankAccount {

protected const decimal WithdrawCost = 0.25M;

public decimal InterestRate { get; }

public SavingsAccount(string bankAccountNumber, decimal interestRate)

: base(bankAccountNumber) {

InterestRate = interestRate;

}

public void AddInterest() {

Deposit(Balance * InterestRate, “add interest”);

}

}

 Methodes: nieuwe methode toevoegen
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Extra constant field

Extra methode

Extra property



 Methodes - overriding
◦ Standaard kan je een methode niet overschrijven in een 

subklasse

◦ voorbeeld: de methode WithDraw in BankAccount kan je niet
overschrijven in de subklasse SavingsAccount
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in Java zou dit wel kunnen…



 Methodes - overriding
◦ Indien je een methode wil override-n moet je in de 

superklasse gebruik maken van het keyword virtual

 Via dynamic binding wordt dan de juiste versie van de methode 
uitgevoerd
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Maakt het mogelijk de methode 
Withdraw te override-n in een 
subklasse van BankAccount



 Methodes - overriding
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Deze Withdraw override de 
Withdraw uit bankAccount. 

public class BankAccount {

public virtual void Withdraw(decimal amount) {

…

Balance -= amount;

}

public class SavingsAccount: BankAccount {

public override void Withdraw(decimal amount) {

base.Withdraw(amount);

base.Withdraw(WithdrawCost);

}

voor Java programmeurs even wennen: 
virtual en override moeten expliciet 

aangegeven worden in de code!



 voorbeeld: Instantie aanmaken van de subklasse
◦ Pas program.cs aan
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Methode uit de subklasse zal 
worden aangeroepen



 Time to commit

 Inspecteer de code

 Commit
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commit “Add class SavingsAccount”



 Klasse Object
◦ Elke klasse is afgeleid van System.Object
◦ Deze bevat 3 overridable methodes

 ToString(), die geeft als standaardgedrag de naam van de klasse weer.

 Equals(), standaardgedrag: 2 reference variabelen zijn gelijk als ze wijzen 
naar hetzelfde object, 2 value type variabelen zijn gelijk als ze dezelfde 
waarde bevatten

 GetHashCode(), gebruikt in hash-based collections: Dictionary<TKey, 
TValue> , Hashtable of type afgeleid van DictionaryBase.

◦ Bevat statische methodes
 ReferenceEqual(objA, objB): test of 2 variabelen wijzen naar hetzelfde

object, of beide null zijn.
 Object.ReferenceEqual(o1,o2)

 Equals(objA, objB): checkt op ReferenceEqual, indien niet gelijk
retourneert het het resultaat objA.Equals(objB)

 Object.Equals(o1,o2)
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 Klasse Object
◦ Pas klasse BankAccount

aan
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 ?: , ternary conditional operator

◦ verkorte schrijfwijze if then else

 ??, null-coalescing operator

◦ retourneert de linkerkant van de 
operand als niet null, anders de 
rechterkant.

 ?., null conditional operator

◦ Test op null alvorens een member 
access te doen

return (a==b)? c : d;

int? length = customers?.Length; // null if customers is null   

Customer first = customers?[0];  // null if customers is null  



 Klasse Object
◦ Pas Program.cs aan

 ToString() mag je achterwege laten
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 Time to commit

 Inspecteer de code

 Commit
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commit “Implement overridable
methods from Object”





 Polymorfisme kan optreden als men overerving 
gebruikt. Zo kan men objecten van een superklasse en 
1 of meerder subklassen van die klasse opslaan in een 
collection die bestaat uit objecten van de superklasse. 

 Er kan ook op een polymorfe manier een object 
methode aangeroepen worden. Hier wordt dan aan de 
hand van het type overervende klasse gekozen welke 
methode er moet worden uitgevoerd. Voorwaarde: de 
methode moet gedefinieerd zijn in de superklasse.

 Het type van een object bepalen kan via de is operator
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BankAccount s = new SavingsAccount("13-455665-13“, 0.10M);

if (s is SavingsAccount) {....}



◦ Voorbeeld
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BankAccount[] accounts = new BankAccount[3];

accounts[0] = new BankAccount("13-455665-13");

accounts[1] = new SavingsAccount("13-455665-13", 0.05M);

accounts[2] = new SavingsAccount("13-455665-14", 0.03M);

foreach (BankAccount a in accounts)

{

a.Withdraw(10M);

}

afhankelijk van het type wordt de Withdraw methode uit de superklasse 
BankAccount, of de Withdraw methode uit de subklasse SavingAccount

aangeroepen





 Een klasse met 1 of meerdere abstracte methodes 
(methodes zonder een implementatie) is een abstracte 
klasse. 
◦ Een abstracte klasse kan zowel abstracte als normale members 

bevatten.

 Van een abstracte klasse kunnen geen instanties worden 
aangemaakt. Je moet klassen hebben die overerven van 
deze klasse om ze te kunnen gebruiken. 

 De declaratie van een abstracte klasse bevat het keyword
abstract.

 Elke afgeleide klasse van een abstracte klasse moet alle 
abstracte members van de abstracte klasse implementeren 
door gebruik te maken van de override keyword, tenzij de 
afgeleide klasse zelf abstract is.
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 Voorbeeld
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public abstract class BankAccount {

public virtual void Withdraw(decimal amount) {…}

public abstract string PrintAccount();

}

BankAccount is nu een abstracte 
klasse en kan niet geïnstantieerd 

worden

elke concrete subklasse van 
BankAccount zal PrintAccount

override-n



 Voorbeeld
◦ Maak de klasse BankAccount abstract

◦ Voeg een abstracte methode toe in BankAccount

◦ Implementeer de methode in SavingsAccount

◦ Merk op: de code compileert nu niet meer. Waarom?
◦ Verwijder de toegevoegde code terug
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public abstract class BankAccount { … }

public abstract string Print();

public override string Print() {

return $"Savingsaccount balance = {Balance}";

}





 Bij wijze van voorbeeld maken we een IBankAccount
interface aan.
◦ Open de klasse BankAccount in het code venster. Rechtsklik > 

Quick Actions > Extract interface
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 Bij wijze van voorbeeld maken we een IBankAccount
interface aan.
◦ The code in the interface 
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merk op: de private setters zouden geen deel uitmaken van de 
geëxtraheerde interface, alles in een interface is publiek 

toegankelijk



 In C# 8.0
◦ Je kan nu ook members toevoegen aan interfaces met een 

default implementatie. Zo kunnen API-ontwikkelaars 
methoden toevoegen aan een interface in latere versies 
zonder de bron- of binaire compatibiliteit met bestaande 
implementaties van die interface te verbreken. Bestaande 
implementaties nemen de standaardimplementatie over.

◦ Voorbeeld op https://docs.microsoft.com/en-
us/dotnet/csharp/tutorials/default-interface-members-
versions
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https://docs.microsoft.com/en-us/dotnet/csharp/tutorials/default-interface-members-versions


 Time to commit

 Inspecteer de code

 Commit
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commit “Add interface IBankAccount”





 Informatie eigen aan de klasse, maar niet 
aan een bepaalde instantie van die klasse

 Gebruik keyword static. 
◦ Voorbeeld static field nrOfAccounts

 Static members zijn altijd toegankelijk, 
ook al zijn er geen instanties van de klasse aangemaakt.
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double result;

result = Math.Cos(45);

public class SavingsAccount: BankAccount {

public static int nrOfAccounts;

int total = SavingsAccount.nrOfAccounts;

Merk op: klassenaam ipv
instance naam!

C# gebruikt de: operator 
voor zowel overerving als 
voor het implemeneteren
van een interface, in Java 

gebruik je hier 
implements



 Static fields worden apart in het geheugen 
bijgehouden en worden gedeeld door alle instanties 
van die klasse.
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 Een klasse kan ook static gemaakt worden
◦ voorbeeld de static class Math

 Statische klassen
◦ hebben enkel static members

◦ kunnen niet geïnstantieerd worden

◦ zijn sealed (geen overerving mogelijk)
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double result;

result = Math.Cos(45);





 De code staat op github
https://github.com/WebIII/03thModelEnUnitTesten
◦ Je kan een clone aanmaken vanuit Visual Studio
◦ Ga naar Team Explorer, klik op het stekker icoon        (Manage 

connections)
◦ Klap “Local Git Repositories” open en klik op Clone
◦ Kopieer de URL vanuit github (Klik daar op Clone or download, en 

dan op het icoon Copy to clipboard))

◦ Meer op 
https://blogs.msdn.microsoft.com/visualstudioalm/2013/02/06/cre
ate-connect-and-publish-using-visual-studio-with-git/
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https://blogs.msdn.microsoft.com/visualstudioalm/2013/02/06/create-connect-and-publish-using-visual-studio-with-git/


◦ Paste de URL in VS, geef ook de target folder op

◦ De repository wordt toegevoegd. Dubbelklikken op de 
repository toont de solution. Dubbelklik de solution om deze 
te openen

Pag. 108



 Wens je de code van een bepaalde commit te bekijken
◦ In  Team Explorer > Klik op Changes > Klik op Actions en 

selecteer View History
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 Wens je een bepaalde commit te bekijken
◦ Dubbelklik op een commit, toont de changes.
◦ Rechtsklik op Commit > New Branch laat toe om een nieuwe branch aan te 

maken. Zo bekom je de code na deze commit en kan je hierin zelf verder 
werken. 
 Wens je vanaf commit 1 terug zelf de code in te geven (de stappen op de 

volgende slides te volgen): rechtsklik deze commit > new branch. Geef naam in 
(mag geen spaties bevatten) en vink checkout branch aan (zo schakel je 
onmiddellijk over naar deze branch)

 Nu werk je in deze branch (de code die in de solution zichtbaar is)

 Switchen van branch (bvb terug naar de master): Team Explorer > Branches > 
dubbelklik op de branch. Je kan alleen switchen van branchals alle wijzigingen 
gecommit zijn. Je kan ze ook stashen (aan de kant zetten voor later gebruik)

 Meer over branches: https://msdn.microsoft.com/en-us/library/jj190809.aspx

 Meer over git : https://www.git-tower.com/learn/git/ebook/en/command-
line/basics/basic-workflow#start

Pag. 110

https://msdn.microsoft.com/en-us/library/jj190809.aspx
https://www.git-tower.com/learn/git/ebook/en/command-line/basics/basic-workflow#start




112Hoofdstuk 8: Testen

TESTEN



 Test Driven Development

 Aanmaken van test bibliotheek

 Aanmaken van unit test
◦ Stappenplan

◦ De 3 AAA’s

◦ Klasse Assert

◦ Testen op exceptions

 Aanmaken van unit testen voor domein Banking

 Aanvullingen

 Tips

 Test List
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https://docs.asp.net/en/latest/testing/unit-
testing.html



 Wanneer unit testen schrijven?
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https://app.pluralsight.com/player?course=domain-driven-design-in-

practice&author=vladimir-khorikov&name=domain-driven-design-in-practice-

m1&clip=8&mode=live

https://app.pluralsight.com/player?course=domain-driven-design-in-practice&author=vladimir-khorikov&name=domain-driven-design-in-practice-m1&clip=8&mode=live


 Test coverage versus Value distribution
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https://app.pluralsight.com/player?course=domain-driven-design-in-

practice&author=vladimir-khorikov&name=domain-driven-design-in-practice-

m1&clip=8&mode=live

https://app.pluralsight.com/player?course=domain-driven-design-in-practice&author=vladimir-khorikov&name=domain-driven-design-in-practice-m1&clip=8&mode=live


 TDD – Motto: Rood, Groen, Refactor

◦ Doe het Falen

 Geen code zonder falende test

◦ Doe het Werken

 Zo eenvoudig  mogelijk

◦ Maak het Beter

 Refactor
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Merk op: in deze cursus 
houden we ons niet strict
aan TDD
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 Aanmaken van unit test project
 Een unit test project is een .Net Core class library dat refereert

 naar de SUT (System under test, het project dat je test) 

 en een test runner. We gebruiken xUnit: http://xunit.github.io/
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http://xunit.github.io/


 Aanmaken van unit test project
◦ Selecteer de solution in Solution explorer.

◦ Rechtermuisknop > Add > New Project

◦ Kies als taal C#, en project type Tests

◦ Selecteer xUnit Test Project (.Net core)

◦ Geef naam van het project in: Banking.Tests
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 Aanmaken van unit test project
Voeg een referentie toe naar de SUT, het project “Banking”

 Rechtsklik References in Banking.Tests> Add Reference > onder 
Projects, selecteer Solution > vink Banking aan

 Dit voegt in project.json Banking toe als dependency

◦ Verwijder de klasse UnitTest1.cs
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 Time to commit

 Inspecteer de code

 Commit
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commit “Add unit test project 
Banking.Tests to solution”



 TIP
◦ Je zal later bestaande testklassen toevoegen aan het project. 

Om zeker te zijn dat je geen compilatie fouten krijgt kan je 
best de repo op github clonen
https://github.com/WebIII/03thModelEnUnitTesten.git

◦ Maak dan een branch aan bij de commit “Add excluded unit 
tests for later use”
 Ga naar View History in Team Explorer 

 Rechtsklik deze commit > New Branch

 Nu codeer je verder in deze branch
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https://github.com/WebIII/03thModelEnUnitTesten.git


 Aanmaken van unit testen
◦ Stappenplan strikt TDD

1. Maak een ontwerp van de klasse

=> Methodes throwen NotImplementedException

2. Maak een testklasse 

3. Schrijf de testen in de testklasse

4. Run de testen. Testen falen

5. Pas de code in de klasse aan

6. Run de testen opnieuw. Testen slagen

7. Refactor indien nodig

8. Run testen. Moeten nog steeds slagen

9. Herhaal 3-9 tot alle gedrag is aangemaakt
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 Stap 2: Aanmaken van een 
testklasse voor BankAccount
◦ Maak de folders Models/Domain aan 

(neem de structuur van gerefereerd 
project over)

◦ Rechtsklik op de folder > Add > New 
Item > Class en noem deze 
BankAccountTest
 Naam testklasse = naam klasse + “Test”
 Maak gebruik van namespace Xunit
 Deze klasse bevat testmethodes. Elke 

testmethode heeft attribuut [Fact] of 
[Theory]
 Facts zijn testen met steeds dezelfde

data.
 Theories zijn data driven unit tests. 

Dezelfde test definitie voor meerdere
test data reeksen.
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 Stap 3: Aanmaken van unit testen
◦ 1 unit test is een methode die test of 1 bepaalde methode 

doet wat ze moet doen gegeven 1 bepaald concreet geval.

◦ Zorg voor duidelijke naamgeving. 

 De naam moet aangeven wat getest wordt

 Conventies:

 NaamTeTestenMethode_BeschrijvingGeval_TeVerwachtenResultaat

OF

 NaamTeTestenMethodeGivenBeschrijvingGevalShouldTeVerwachten
Resultaat
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 Stap 3: Aanmaken van unit testen
◦ AAA: de normale flow in een unit test

 Arrange: Initialisatie: Maak een object van de te testen klasse, 
initialiseer variabelen,…

 Act: Roep de te testen methode op

 Assert: Controleer of de methode correct is uitgevoerd. 

 2 strekkingen

 1 assert/test

 Meerdere asserts/test op voorwaarde dat je 1 type gedrag test
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 Stap 3: Aanmaken van unit testen
◦ Welke testen aanmaken: wees creatief!!!

 Baseer je op use case, maar denk verder. Bedenk alternatieven.

 Test zeker één normaal geval,  maar vooral alle mogelijk foute 
gevallen en grensgevallen (bvb i.g.v. parameters: alle mogelijke 
inputwaarden voor parameter)

 Geef betekenisvolle namen aan de test methodes

 Zie cursus Ontwerpen I en II

 Schrijf enkel testen voor methodes/properties met gedrag. 
Automatic props dien je niet te testen.
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 Stap 3: Aanmaken van unit testen
◦ Aanmaken van unit test voor constructor BankAccount

 Welk gedrag willen we testen?

 Balance is 0 voor een nieuwe bankaccount

 AccountNumber bevat de opgegeven waarde

 Eerste test: balance=0 voor nieuwe bankaccount

 Naam methode: NewAccount_BalanceZero

 Unit test retourneert steeds void

 Bevat het attribuut [Fact] -> namespace Xunit!

 Test classes moeten ook public zijn !!!!
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 Stap 3: Aanmaken van unit testen
◦ Aanmaken van unit test voor constructor BankAccount

 Arrange: Initialiseer de nodige variabelen
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 Stap 3: Aanmaken van unit testen
◦ Aanmaken van unit test voor constructor BankAccount

 Act: Voer test effectief uit → roep de te testen methode op

 Voeg bovenaan de klasse volgende using toe, nodig voor klasse 
BankAccount

 using Banking.Models; 

 de foutmelding “BankAccount is unaccessible due to its protection level” => 
oplossing : pas modifier aan van de class BankAccount. Moet public zijn, 
daar het gebruikt wordt in een andere assembly
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 Stap 3: Aanmaken van unit testen
◦ Aanmaken van unit test voor constructor BankAccount

 Assert: vergelijk bekomen resultaat met verwachte resultaat. 

 De klasse Assert

 Assert.Equal(expected, actual)

 Test of de waarde van expected gelijk is aan de waarde van actual.

 Alle primitieve datatypes

 Vergelijken van objecten gebeurt op reference basis. Dit kan je 
aanpassen door de Equals methode te implementeren

 Assert.NotEqual(expected, actual): idem maar test op verschillend

 Assert.(Not)Same(expected, actual): expected en actual wijzen naar
hetzelfde object.

 Assert.True(bool conditie), Assert.False(bool conditie)

 Test of conditie gelijk is aan true/false
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 Stap 3: Aanmaken van unit testen
◦ Aanmaken van unit test voor constructor BankAccount

 De klasse Assert

 Assert.(Not)Null(actual)

 Test of actual (niet) gelijk is aan null

 Assert.Empty(actual)

 Test of collection leeg is

 Assert.Contains(item, collection), Assert.DoesNotContain(item, coll)

 Test of collection item bevat

 T result = Assert.Is(Not)Type<T>(actual)

 Test of actual instantie is (exact) van het type T. 

 T result = Assert.IsAssignableFrom<T>

 Test of actual instantie is van het type T (mag ervan erven)
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 Stap 3: Aanmaken van unit testen
◦ Aanmaken van unit test voor constructor BankAccount

 We maken een BankAccount aan. Hiervoor dient de klasse BankAccount
public te zijn. Pas aan. Doe dit voor alle klassen in de models folder

 Assert: vergelijk verwachte resultaat (1ste parameter) met het bekomen
resultaat (2de parameter)

Pag. 135



 Stap 4: Run Test: 
 We gebruiken Live Unit Testing.

 We starten dit in Menu >  Test > Live Unit Testing > Start

 Alle testen worden uitgevoerd (op dit ogenblik maar één) en 
slaagt.

 We gaan nu nog testen toevoegen. Van zodra je het bestand 
‘saved’, worden de testen uitgevoerd.

 De test runt, als hij slaagt . Als faalt

 Meer informatie over Live unit testing op: 
https://blogs.msdn.microsoft.com/visualstudio/2017/03/09/live-
unit-testing-in-visual-studio-2017-enterprise/#integrated

Pag. 136

https://blogs.msdn.microsoft.com/visualstudio/2017/03/09/live-unit-testing-in-visual-studio-2017-enterprise/#integrated


 Stap 4: Run Test: 
 Je krijgt ook onmiddellijk feedback over de code coverage. Open 

BankAccount.cs

 Of als je een test aan het wijzigen bent, tot je de testen opnieuw
gerund hebt

 Als je op een feedback icon klikt krijg je een overzicht van de 
testen, en kan je zo de testen opnieuw runnen,… Hover een failed 
test toont de reden
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 Aanmaken van unit test voor constructor BankAccount
◦ Oefening: Maak een 2de test aan: Creatie bankaccount, 

rekeningnummer moet overeenkomstig rekeningnummer zijn

 De test zal automatisch worden uitgevoerd.
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 Aanvullingen: 
◦ Beide testmethodes hebben dezelfde arrange/act code

◦ Oplossing: Voorzie een SetUp en TearDown methode die runt 
respectievelijk voor en na de uitvoering van elke test

 Declareer private variabele die binnen elke testmethode gebruikt
kunnen worden in testklasse

 Setup: maak een parameterloze constructor aan en initialiseer de 
variabelen

 VS voert de constructor
uit VOOR de uitvoering
van iedere testmethode
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 Aanvullingen: 
◦ Beide testmethodes hebben dezelfde arrange/act code

 TearDown: Wens je de variabelen op te kuisen na het runnen van 
elke test:

 Laat de testklasse erven
van IDisposable

 Implementeer de opkuis
in de methode Dispose

 VS voert deze methode
uit na iedere test 
methode-uitvoering
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 Aanvullingen: 
◦ Unit test die gebruik maakt van SetUp
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 Aanmaken test NewAccount_EmptyString_Fails
◦ Arrange en Act

◦ Wat met exceptions?
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 Aanmaken test NewAccount_EmptyString_Fails
 Testen op Exceptions

 Als je foutieve parameterwaarden meegeeft aan een test methode
moet deze methode een exception throwen.

 Assert.Throws<T>(lambda expression) met 

 T de exception klasse, controleert of de exception gethrowd wordt

 Een lambda expressions. Gebruik de schrijfwijze

 () => methodeAanroep

 Lambda’s worden uitvoerig behandeld in het volgende hoofdstuk.
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 Aanmaken test NewAccount_EmptyString_Fails
 De test faalt…

 Of ga naar Test > Live Unit testing Window
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 Aanmaken test NewAccount_EmptyString_Fails
 Code aanpassen…. Maak van AccountNumber een full property. 

Selecteer AccountNumber, kies Quick Actions, convert to full property. 
De code maakt gebruik van lambda’s (zie volgend hoofdstuk). Klik terug
op Quick Actions en kies « Use block body for property ». Wijzig de naam
van het attribuut in _accountNumber.

 … en de testen slagen
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 Nog meer testen voor BankAccount…
◦ Klik in de Solution Explorer op Show All Files icon

◦ Rechtsklik op BankAccountTest2.cs > Include in project

◦ Het accountnr moet aan bepaalde regels voldoen, anders wordt
een exception gethrowed

◦ Overzicht van de testen:
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Naam test Rekeningnummer Gevolg

NewAccount_EmptyString_Fails string.Empty ArgumentException

NewAccount_Null_Fails Null ArgumentNullException

NewAccount_TooLong_Fails “133-4567890-0333“ ArgumentException

NewAccount_WrongFormat_Fails “063-1547563@60 “ ArgumentException

NewAccount_NoDivisionBy97_Fails “133-4567890-03” ArgumentException



 Nog meer testen voor BankAccount…
 Bekijk de testen. Als ze niet runnen : Test > Live Unit Testing > Stop 

en dan terug starten

 Enkele nieuwe testen falen

 Pas de code aan…
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 Unit testen voor BankAccount. 
◦ aanpassingen aan de property AccountNumber

◦ zie help voor Regex, Match
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Opm : door @ hoeven we 
niet \\ te schrijven

Deze blok code mag weg 
want gebruik van de Regex
en Match vangt dit op deze 
manier op (..) laat toe 

subexpressies te 
schrijven, die 
nadien als groep te 
extraheren zijn

Named matched 
subexpressions : 
(?<name>subexpression)

nameOf operator : return de naam van een variabele



 Theory
◦ Data-driven testen. 

◦ Enkel accountNumber is verschillend in vorige unit testen
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1 parameter die de 
waarde van  het 
testgeval zal bevatten

InlineData: Alle testgevallen



 Unit testen voor Deposit/Withdraw die reeds slagen
 Withdraw_AmountBiggerThanZero_ChangesBalance

 Arrange: nieuwe bankrekening met geldig nummer

 Act: Deposit 200, Withdraw 100

 Assert: Balance = 100

 Maar ook met als de balans onder 0 gaat : bvb 200 storten en dan 300 
afhalen

 Deposit_AmountBiggerThanZero_ChangesBalance

 Arrange: nieuwe bankrekening met geldig nummer

 Act: Deposit 100

 Assert: Balance = 100
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 Unit testen Deposit/Withdraw falen
◦ Maak zelf de testen aan voor

 Withdraw_NegativeOrZeroAmount_Fails() 

 Deposit_NegativeOrZeroAmount_Fails()

◦ run de testen…

◦ Pas de code aan en laat ze slagen!
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 Unit testen (TDD)
Deposit/Withdraw
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public virtual void Withdraw(decimal amount) {
if (amount < 0)

throw new ArgumentException("Amount cannot be negative");
transactions.Add(new Transaction(amount, TransactionType.Withdraw));
Balance -= amount;

}

public void Deposit(decimal amount) {
if (amount < 0)

throw new ArgumentException("Amount cannot be negative");
transactions.Add(new Transaction(amount, TransactionType.Deposit));
Balance += amount;

}

[ExpectedException(typeof(ArgumentException))]
[TestMethod]
public void WithdrawNegativeAmountNotAllowed()
{

bankAccount.Withdraw(-100);
}

[ExpectedException(typeof(ArgumentException))]
[TestMethod]
public void DepositNegativeAmountNotAllowed()
{

bankAccount.Deposit(-100);
}

oefening: pas de code aan

oefening: schrijf de gepaste testen



 We hebben verschillende opties om de validatie te
doen
◦ In de withdraw en deposit method? Maar dan duplicate code

◦ In de Transaction klasse

 In de constructor

 Of in een private setter
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 Testen van de klasse Transaction
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 Live unit testing
◦ In de code kan je per method de testen zien en of ze al dan

niet slagen (hover over v of x voor de methode)
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 CodeLens
◦ In te stellen via Tools > Options > Text Editor > All Languages > 

Code Lens

◦ Hiervoor dien je de testen wel te runnen via Test > Windows > 
Test Explorer en dan “Run all”

◦ Toont boven elke methode het aantal testen en de aantal 
testen die slagen (testen moet je gerund hebben)
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 Andere manier om testen te runnen
◦ Test > Run all Tests

◦ Rechtsklik in een testklasse > Run tests

◦ Rechtsklik op een test > Run test

◦ Via Test > Test Explorer kan je het resultaat bekijken
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 CodeCoverage
◦ Test Analyze Code Coverage for All

 Toont het % van de code die door de testen getest wordt.
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 Tips
◦ 1 methode test 1 item. 2 strekkingen

 Ideaal 1 Assert/test methode

 OF meerdere asserts/test maar methode test 1 type gedrag

◦ Nadelen van veel Asserts in 1 methode

 Als 1 Assert binnen test methode faalt, voert VS de rest methode niet uit

 De methode wordt moeilijk te lezen

 De kans dat je in de methode een bug schrijft wordt groter

 De kans dat je de methode moet debuggen wordt groter

◦ De werking van 1 test methode mag niet afhangen van de werking 
van een andere testmethode

◦ Testmethodes moeten in willekeurige volgorde kunnen uitvoeren.

◦ Schrijf geen testen voor bestaande libraries die je gebruikt of voor 
gegenereerde code (get/set)
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 Time to commit

 Inspecteer de code

 Commit
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commit “Add Unit tests for 
BankAccount”



 Testen van de klasse Transaction
◦ Voeg de klasse TransactionTest aan de Models folder 

(rechtsklik Include in project)

◦ Run de testen in de klasse TransactionTest

◦ De testen slagen allemaal
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 Testen van BankAccount Transaction
◦ Voeg BankAccountTransactionTest.cs toe aan project

◦ De testen zijn nog niet volledig geimplementeerd

 Deze testen worden aangeduid met de Skip parameter

 Implementeer deze testen, verwijder de Skip parameter. 

 Bekijk de overige
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 Aanpassen van BankAccountTransactionTest
◦ Deposit_Amount_AddsTransaction moet nagaan of transactie 

is toegevoegd.

 Probleem: IEnumerable laat enkel toe om de collectie te 
overlopen. Aantal en elementen via index kunnen niet worden 
opgevraagd

 vorm de IEnumerable om omdat we toegang moeten krijgen tot 
het eerste element uit de collectie…
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ToList() kan je ook 
gebruiken



 Aanpassen van BankAccountTransactionTest
◦ GetTransactions_NoParameters_ReturnsAllTransactions() 

moet nagaan of alle transacties geretourneerd worden.

 Probleem: IEnumerable laat enkel toe om de collectie te 
overlopen. Aantal en elementen via index kunnen niet worden 
opgevraagd
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Of new List<T>() of ToList(), maar dan de Count property gebruiken



 Time to commit

 Inspecteer de code

 Commit
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commit “Add Unit tests for 
Transaction”



 SavingsAccount
◦ Voeg SavingsAccountTest.cs toe aan Models folder 

Banking.Tests

◦ run de testen…

◦ Voeg 2 testen toe

 Implementeer de test Withdraw_IfBalanceGetsNegative_Fails

 Je mag niet in het rood gaan op een SavingsAccount. Dit throwt een 
InvalidOperationException (TDD)

 Doe de test eerst falen

 Pas de code aan

 De test moet slagen
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 SavingsAccount
◦ Implementeer de test AddInterest_ChangesBalance

 De test zal onmiddellijk slagen, want de code is reeds 
geïmplementeerd in SavingsAccount.

 Het is best practice om een test altijd eerst te laten falen. Plaats
daarom de code in SavingsAccount die de test doet slagen eerst in 
commentaar

 Dan faalt de test

 Dan plaats je de code weer uit commentaar

 Dan moet de test slagen
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 SavingsAccount
◦ Voeg twee testen toe:
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 SavingsAccount
◦ Voeg twee testen toe:
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 Time to commit

 Inspecteer de code

 Commit

Pag. 170

commit “Add Unit tests for 
SavingsAccount”



 Refactor de code
◦ Maak van Balance in BankAccount een berekende property. 

 Overloop alle transacties en bepaal zo het total

 Alle testen zouden nog steeds moeten slagen.
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commit “Refactor property Balance in 
BankAccount”



 Advanced: use Theory and MemberData

◦ Ga terug naar de Master branch. Bekijk de klasse 
BankAccountTransactionTest.cs

◦ Nu wordt gebruik gemaakt van Theories. Maar daar de Inline
data geen constante waarden bevat dient een MemberData
object te worden aangemaakt

◦ Bekijk de code. Meer info op 
http://www.martinwilley.com/net/code/test/parametrized.ht
ml

◦ commit “Refactor unit test BankAccountTransaction: gebruik
van Theory and MemberData”
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commit “Refactor unit test 
BankAccountTransaction: gebruik van 
Theory and MemberData”

http://www.martinwilley.com/net/code/test/parametrized.html
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 Start met /// (triple slash) gevolgd door 1 van 
onderstaande XML elementen
◦ Rechtstreeks in code toevoegen 

◦ Of in Class Diagram > Details View > Summary kolom



◦ Voorbeeld

◦ In VS: documentatie wordt getoond

/// <summary>

/// Constructor

/// </summary>

/// <param name="account">Number of bank account</param>

public BankAccount(string account)



 Generatie xml file
◦ Via command prompt VS 

 Csc /doc:DocBankAccount.xml c:/…./*.cs

◦ Instellen in VS, wordt bij compilatie automatisch gegenereerd
 Selecteer project: bvb BankingLibrary. Ga naar de Build tab van 

zijn Properties. Vul pad en filenaam in

 Generatie andere formaten (html,..) vertrekkende van 
xml file: 
◦ NDoc: http://sourceforge.net/projects/ndoc

http://sourceforge.net/projects/ndoc
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 List collecties
◦ elementen van een collectie zijn toegankelijk via een index

 zero-based indexing

◦ het contract voor op index gebaseerde collecties ligt vast in 
IList<T>

◦ List collecties zijn efficient 

 geheugengebruik

 snelheid om elementen te benaderen
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T T is het type van 
de elementen in de 

collectie



 Dictionaries
◦ elementen in de collectie bevatten een key-value pair

◦ elementen van de collectie zijn toegangkelijk via de key

◦ het contract voor dictionaries ligt vast in IDictionary<TKey, 
TValue>

◦ dictionaries zijn meestal geïmplementeerd als een hash tabel
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Thet type van de keys het type van de values
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 IDictionary<Tkey, TValue>

 Of verkort met dictionary initializer
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 IDictionary<Tkey, 
TValue>

◦ Methodes
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 Dictionary<Tkey, TValue>
◦ Concrete collectie met key/waarde paren

 SortedDictionary<Tkey, TValue>

◦ Collectie key/waarde parent, gesorteerd op de key
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 Sets
◦ focus van deze collecties is niet zozeer op de afzonderlijke

elementen maar op al de elementen in de collectie samen

 er is geen lookup mechanisme om 1 element van een set op te
halen

◦ sets kan je gemakkelijk combineren

 ~verzamelingen: unie, verschil, …

◦ het contract voor sets ligt vast in ISet<T>
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 Dictionaries vs Sets
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 Raadplegen van collecties
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 Wijzigen van collecties
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 Overzicht C# collections
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deze non-generic types
(zoals ArrayList)

kan je nog tegenkomen 
(backwards compatibility)

deze collections zal je het 
meest courant gebruiken



 Overzicht C# collections
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dit wordt in een apart 
hoofdstuk behandeld: zie 

Hfst 05Linq



 ARRAY
◦ is een reference type

◦ declaratie/initialisatie

 array initializers
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 ARRAY
◦ Enumereren: for/foreach
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 ARRAY
◦ Enumereren: 

 met foreach kan je de elementen van de array niet vervangen

 als de elementen een reference type zijn kan je kan wel de 
elementen veranderen (via de reference)
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 ARRAY
◦ Wat kan je doen met array’s?

 zie documentatie op msdn: Array Class!

 enkele properties…

 Length

 enkele methods…

 BinarySearch

 FindAll

 Sort

 Copy/CopyTo

 IndexOf

 …
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 nog meer collections:
◦ Queue<T> 

 first-in, first-out collectie van objecten

◦ Stack<T> 

 Represents a variable size last-in-first-out (LIFO) collection of 
instances of the same arbitrary type.

◦ LinkedList<T>

 Represents a doubly linked list.

◦ SortedSet<T>

 Represents a collection of objects that is maintained in sorted 
order.
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 yield return
◦ Voor het bouwen van een IEnumerable
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De eerste iteratie in foreach loop zorgt voor

de uitvoering van de ComputeAges t.e.m. 

het eerste yield return statement. Deze

iteratie retourneert 21, en de huidige locatie

in de ComputeAges methode wordt

behouden. 

Bij de volgende iteratie in foreach gaat de 

uitvoering in de iteratie methode

ComputeAges verder en wordt 22 

geretourneerd,…. tot einde iteratie methode

bereikt



 Generieke klassen kapselen operaties, die niet 
specifiek voor een bepaald gegevenstype zijn, in. 

 Het meest voorkomende gebruik voor generieke 
klassen zijn collecties zoals linked lists, hash tables, 
stacks, queues, trees, enzoverder. 

 Bewerkingen zoals het toevoegen en verwijderen van 
objecten uit de collectie worden uitgevoerd op 
dezelfde manier, ongeacht het type gegevens dat 
wordt opgeslagen.
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 Je kan constraint toevoegen aan T
◦ Je kan eisen dat T een class of struct is

◦ Je kan eisen dat T een public default constructor heeft 

 Nodig als je ergens in een methode de default constructor 
aanroept, anders krijg je compilatiefout

◦ Je kan eisen dat T erft van een interface of van base class
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 Tutorial : https://docs.microsoft.com/en-
us/dotnet/csharp/tutorials/nullable-reference-types
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https://docs.microsoft.com/en-us/dotnet/csharp/tutorials/nullable-reference-types


 Unit Testing with Visual Studio: Freeman, A. (2014). 
Pro ASP.NET MVC 5 (p. 784). Apress, hoofdstuk 6, p137 
– p145.

 Pluralsight: cursus C# Fundamentals with C# 5.0 van 
Scott Allen

 Pluralsight: cursus C# Collections Fundamentals van 
Simon Robinson
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 Tutorial: 
◦ https://www.microsoftvirtualacademy.com/

◦ http://www.csharp-station.com/Tutorial.aspx

 C# Programming Guide:
◦ http://msdn.microsoft.com/en-us/library/67ef8sbd.aspx

 C# Reference: 
◦ http://msdn.microsoft.com/en-us/library/618ayhy7.aspx
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